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Introduction
 this chapter

Installation and licensing

Platform and system 
requirements

Before you install

Installing Autodesk 
MapGuide and utilities
This document describes new and changed features in 

Autodesk MapGuide Release 6.3. If you are new to 

Release 6, use this document, along with the “What’s 

New in Release 6” section in the Autodesk MapGuide User’s 

Guide to learn about all Release 6 enhancements. 

Autodesk MapGuide Release 6.3 enhancements include: 

Data Support

■ Autodesk MapGuide Author (See page 10.)

■ Autodesk MapGuide Server (See page 26.)

■ Autodesk Spatial Data Providers (See page 26.)

■ Autodesk MapGuide Viewers (See page 34.)

■ SDF Loader (See page 58.)

Keyboard Accessibility

■ Autodesk MapGuide Author (See page 11.)

■ Autodesk MapGuide Server Admin (See page 29.)

■ Autodesk MapGuide Viewers (See page 34.)

■ Symbol Manager (See page 46.)

■ Raster Workshop (See page 52.)
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Installation and Licensing

The installation and licensing process is streamlined and improved in this 
release. Enhancements include combined installations of Autodesk 
MapGuide Server and the Autodesk Spatial Data Providers for Oracle Spatial, 
SDF, and SHP. Authorization is also removed from all components, with the 
exception of Autodesk MapGuide Server.

“Installing Autodesk MapGuide and Utilities” on page 5 describes how to 
install Autodesk MapGuide Release 6.3 and related utilities. For late-breaking 
installation updates and known issues, please refer to the Autodesk MapGuide 
Readme (MGReadme.htm) located on the Autodesk MapGuide installation CD 
and to the Autodesk MapGuide LiteView Readme (LVReadme.htm) located on 
the Autodesk MapGuide LiteView installation CD. 

Platform and System Requirements

The following are platform and system requirements for Autodesk MapGuide 
Release 6.3 and related utilities.

Autodesk MapGuide Server and Spatial Data 
Providers for SDF, SHP, and Oracle Spatial

■ Intel® Pentium®-based PC

■ Microsoft Windows NT 4.0 Server (Service Pack 6a or later) or Microsoft 
Windows 2000 Server (Service Pack 3 or later) with one of the following: 
Microsoft Internet Information Server 5.0, Microsoft Internet Information 
Server 4.0, Netscape® Enterprise Server 3.6 (Service Pack 3) or iPlanet™ 
Web Server Enterprise 4.1 (Service Pack 8)

■ Microsoft Data Access Components (MDAC): MDAC 2.7 RTM (included 
on the Autodesk MapGuide product CD)

■ Microsoft Internet Explorer 4.x or later

■ 128 MB RAM

■ 260 MB free disk space (plus space for your data)

■ VGA or higher resolution video adapter
2 | Chapter 1 Introduction



Autodesk MapGuide Author and Symbol 
Manager

■ Intel® Pentium®-based PC

■ Microsoft® Windows® 2000 Professional, Windows 98 SE, or Windows 
NT® 4.0 (Service Pack 6a or later) 

■ Microsoft Internet Explorer 5.x or 6.0 or Netscape® Navigator 4.x

■ 32 MB RAM

■ 170 MB free disk space

■ Super VGA or better video display

Autodesk MapGuide Viewers

Autodesk MapGuide provides three different kinds of Viewers: ActiveX 
Control, Plug-In, and Java Edition.

Autodesk MapGuide Viewer ActiveX Control 

■ Intel® 486- or Pentium®-based PC 

■ Microsoft Windows XP Home Edition or Professional (Service Pack 1 or 
later), Windows 2000 Professional, Windows 98 SE, or Windows NT 4.0 
(Service Pack 6a or later) 

■ 16 MB RAM (24 MB required if using Windows NT 4.0)

■ Microsoft Internet Explorer 5.x or 6.0

Autodesk MapGuide Viewer Plug-In 

■ Intel® 486- or Pentium®-based PC 

■ Microsoft Windows 2000 Professional, Windows 98 SE, or Windows NT 
4.0 (Service Pack 6a or later) 

■ 16 MB RAM (24 MB required if using Windows NT 4.0)

■ Mouse or compatible pointing device

■ Netscape® Navigator 4.x
Platform and System Requirements | 3



Autodesk MapGuide Viewer Java Edition

Autodesk MapGuide Viewer Java Edition supports Windows, Macintosh, and 
Solaris operating systems.

Windows

■ Intel® 486- or Pentium®-based PC 

■ Microsoft Windows 2000 Professional, Windows 98 SE, or Windows NT 
4.0 (Service Pack 6a or later) 

■ 16 MB RAM (24 MB required if using Windows NT 4.0 and Microsoft Inter-
net Explorer)

■ Netscape Navigator 4.7 or Microsoft Internet Explorer 5.x or 6.0

Macintosh

■ Apple® Macintosh® computer 

■ Mac® OS 9.1

■ 32 MB RAM (64 MB or more recommended)

■ Microsoft Internet Explorer 5.x with Java VM MRJ 2.2.4

Solaris

■ Sun SPARCstation™ 

■ Sun Solaris™ 2.6 or 2.8

■ 64 MB RAM

■ Netscape Navigator 4.7

Before You Install

Before installing Autodesk MapGuide, be sure your server and client 
computers meet or exceed the platform and system requirements for 
Autodesk MapGuide. Also, be sure to consider the following pre-installation 
requirements:

Autodesk MapGuide and Utilities

Before installing Autodesk MapGuide components and utilities, you must 
first install Internet Explorer 4.x or later.
4 | Chapter 1 Introduction



Autodesk MapGuide Server

■ Microsoft Windows Installer (MSI) must be present on your computer. MSI 
is included with Microsoft Windows 2000. If you do not have MSI on your 
computer, the Autodesk MapGuide Server installation program will install 
the MSI software for you. You will then need to restart your computer and 
manually restart the Autodesk MapGuide Server installation.

■ If Autodesk MapGuide Server Release 5 is installed on your machine, 
ensure that you have also installed patch release 5.0.8.x. before installing 
Autodesk MapGuide Server Release 6.3. You can download this patch from 
the Data and Downloads section of http://www.autodesk.com. If you did 
not install the 5.0.8.x patch release, you must uninstall Autodesk 
MapGuide Server Release 5 before installing Autodesk MapGuide Server 
Release 6.3.

Autodesk MapGuide Viewers

■ If you will be using Microsoft Internet Explorer, you must install it before 
installing Autodesk MapGuide Viewer.

■ If you are installing Autodesk MapGuide Viewer Java Edition, be sure to 
uninstall any previous versions first.

Installing Autodesk MapGuide and Utilities

Autodesk MapGuide is distributed on two installation CDs: one for Autodesk 
MapGuide LiteView, and one for all other Autodesk MapGuide components 
and utilities. From the Autodesk MapGuide installation CD, you can install:

■ Autodesk MapGuide Server, including following Spatial Data Providers 
(SDPs):

■ Autodesk Provider for SDF

■ Autodesk Provider for SHP

■ Autodesk Provider for Oracle Spatial (if an Oracle client is present)

■ Autodesk MapGuide Author, including Symbol Manager

■ Autodesk MapGuide Documentation

■ Adobe Acrobat Reader (for viewing the documentation)

■ Autodesk MapGuide Viewers 
Installing Autodesk MapGuide and Utilities | 5



■ Utilities, including:

■ Raster Workshop (15 MB)

■ SDF Loader (85 MB)

■ SDF Component Toolkit (160 MB)

■ Dynamic Authoring Toolkit (16 MB)

Each Autodesk product is subject to the terms detailed in the license agree-
ment that accompanies it. Before continuing, please read and accept the 
terms in the license agreement presented during the installation procedure.

To install Autodesk MapGuide components and utilities

1 Log on with administrative privileges.

2 Close all open applications.

3 Insert the Autodesk MapGuide CD into the CD-ROM drive. If the setup 
program does not start automatically, double-click the setup.exe file on the 
CD. From the initial installation screen, perform the following steps:

4 Select the component you want to install and follow the on-screen 
instructions to complete the installation. Your choices are: Autodesk 
MapGuide Server, Autodesk MapGuide Author, Autodesk MapGuide doc-
umentation, and Adobe Acrobat Reader. Repeat this step until you have 
installed all of the components you want to install.

Note After installing Autodesk MapGuide Server, you will need to restart your 
computer before installing other components.

5 Select Proceed to: Autodesk MapGuide Viewers. On the screen that 
appears, select the kind of Viewer you want to install. Follow the on-
screen instructions to complete the installation and repeat this step until 
you have installed all of the Viewers you want to install:

■ Autodesk MapGuide Viewer ActiveX Control is for Microsoft Internet 
Explorer on Microsoft Windows platforms only. 

■ Autodesk MapGuide Viewer Plug-In is for Netscape Navigator on 
Microsoft Windows platforms only. 

■ Autodesk MapGuide Viewer Java Edition is for Microsoft Windows, 
Apple Macintosh, and Sun Solaris platforms. Select Installing Autodesk 
MapGuide Java Edition (JAR File) for instructions on how to set up the 
Java Edition for download from a Web server.

■ To set up an automatic installation of the ActiveX Control on client 
machines, select Installing Autodesk MapGuide ActiveX Control (CAB 
File) for instructions on how to set up the automatic installation.
6 | Chapter 1 Introduction



6 Select Proceed to: Utilities. On the screen that appears, select the utility 
you want to install: Raster Workshop, SDF Loader, SDF Component Tool-
kit, or Dynamic Authoring Toolkit. Follow the on-screen instructions to 
complete the installation, and repeat this step until you have installed all 
of the utilities you want to install.

7 When you have finished installing components and utilities, select Finish 
from the installer.

8 Reboot your computer.

Note When you install Autodesk MapGuide Server, MIME types for the MLF, 
MDF, and MWF file formats are created in the default Internet Information 
Server (IIS) properties. However, when information is requested from 
Autodesk MapGuide Author or from the Plug-In Viewer, IIS will not return the 
appropriate MIME type header until you either reboot your computer or use 
the IIS admin to add the following three MIME types to the Web Server (not 
the IIS Master) file types:

■ mdf application/x-mdf

■ mlf application/x-mlf

■ mwf application/x-mwf
Installing Autodesk MapGuide and Utilities | 7
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Autodesk MapGuide Author
 this chapter

Data support

Keyboard accessibility
This chapter describes data support and keyboard 

accessibility enhancements for Autodesk MapGuide 

Author.
9



Data Support

This section describes data support enhancements for Autodesk MapGuide 
Author.

Autodesk DWF (Design Web Format) Support

Autodesk DWF™ (Design Web Format™) is a fast, efficient way to distribute 
design data over the Web. If a DWG file, an SDF file, or a database contains 
valid DWF URLs, Autodesk MapGuide Author launches Autodesk Express 
Viewer when you double-click an object containing a DWG link. This viewer 
then displays the DWF file content. To be valid, a DWF URL must be in a URL 
property column of the DWG file, SDF file, or database.

Note To take advantage of this functionality, you must first install Autodesk 
Express Viewer. You can download Autodesk Express Viewer from the following 
location: http://www.autodesk.com/expressviewer.

Raster Image Rotation Support

Autodesk MapGuide Author can display rotated raster images if the image 
already contains rotation information. Autodesk MapGuide will interpret the 
rotation coordinates and display the image accordingly. For more informa-
tion, see “Working with Rotation and Transparency” on page 52.

Oracle Spatial Data Support

Autodesk MapGuide Author supports Oracle Spatial multi-point collection 
geometry objects. In previous Autodesk MapGuide releases, only the first 
point in the collection was displayed; now all points are displayed.

Working with Oracle Spatial Views

Autodesk MapGuide Author supports Oracle Spatial Views that contain 
geometry columns. To access such a View, you must add the View to the 
Oracle USER_SDO_GEOM_METADATA table. Autodesk MapGuide Server 
uses this table to determine which Views contain geometry columns. 

To update the METADATA table

1 Create the Oracle View you want to access and be sure to include a 
geometry column.

2 Add the new View to the USER_SDO_GEOM_METADATA table.
10 | Chapter 2 Autodesk MapGuide Author



When added to the USER_SDO_GEOM_METADATA table, the View can be 
accessed by Autodesk MapGuide Author. Since this will be a new View, you 
must manually select the KEY column in Autodesk MapGuide Author when 
accessing the View for the first time.

Example

The following SQL commands insert an entry in the 
USER_SDO_GEOM_METADATA table for the ALLTYPES_VIEW View. This entry 
defines two data dimensions as X and Y, sets the extents to +-100 for both:

INSERT INTO USER_SDO_GEOM_METADATA
VALUES ('ALLTYPES_VIEW', 'F_GEOM',
MDSYS.SDO_DIM_ARRAY(MDSYS.SDO_DIM_ELEMENT('X', -100, 100, 0.005),
MDSYS.SDO_DIM_ELEMENT('Y', -100, 100, 0.005)),
NULL);

Keyboard Accessibility

The Autodesk MapGuide Author user interface is enhanced to improve 
keyboard accessibility, including keyboard shortcuts, menu updates to 
display common keyboard shortcuts, and screen changes for input focus 
designation. 

Shortcut keys are single keys or key combinations that perform specific 
actions, such as map navigation, user interface navigation, and toolbar func-
tionality. Use shortcut keys as an alternative to the mouse when working in 
Autodesk MapGuide Author.

Most menu titles and menu items have underlined characters in their labels. 
These characters are called access keys or hot keys. You can press ALT along 
with the access key to activate the menu item anywhere within the active 
window. 

Input Focus

As with all applications running under Windows, only one window at a time 
can receive input from the keyboard. The window that receives this input is 
the window with input focus. 

Map Explorer Input Focus 

The Map Explorer within Autodesk MapGuide Author displays a hierarchical 
list of layers. When the Map Explorer has input focus, the layer item is high-
lighted using the Control Panel Appearance color settings for Selected Items. 
Keyboard Accessibility | 11



When the Map Explorer does not have input focus, it displays Inactive 
Selected Items color settings.

Map Window Input Focus 

The Map Window within Autodesk MapGuide Author displays the map. A 
Map Window with input focus has a rectangular inset border 

General Windows Shortcuts

The following general shortcut keys work for Microsoft Windows applica-
tions.

Operation Shortcut Key

Close the active dialog box/application ALT + F4

Opens the shortcut menu for the active window ALT + SPACEBAR

Switch between open applications ALT + TAB

Cycle through applications in the order opened ALT + ESC

Display Windows Start Menu CTRL + ESC

Activate shortcut menu (if present) Windows 
Application key 
or SHIFT + F10

Move forward among open document windows CTRL + F6

Move backward among open document windows CTRL + SHIFT + 
F6
12 | Chapter 2 Autodesk MapGuide Author



General Shortcut Keys

The following general shortcut keys work throughout the Autodesk 
MapGuide Author application.

Operation Shortcut Key

Cycle input focus forward between Map Window and Map 
Explorer

TAB

Cycle input focus backward between Map Window and Map 
Explorer

SHIFT+TAB

Set input focus to Map Explorer [

Set input focus to Map Window ]

Display Help F1

Reload data F5

Open the menu bar F10 or ALT

Open a popup menu (if present) SHIFT + F10 or
CTRL + SHIFT + 
F10

Close the active map when multiple maps are open CTRL + F4

• Stop data loading
• Cancel tool (return to Select mode) 
• Clear selection when features are selected in map 

Esc
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Main Menu Shortcut Keys

The following shortcut keys are used to activate menu items appearing on 
the Autodesk MapGuide Author main menu bar. An ellipsis (…) after the 
menu item indicates that a dialog box will be displayed after the command 
is chosen.

Operation Shortcut Key

Create a new map CTRL + N

Open an existing map CTRL + O

Save the active map CTRL + S

Print the active map CTRL + P

Copy CTRL + C

Enter the Select mode (First, input focus is set to Map Window 
before action is invoked)

1

Enter the Select mode to select map feature within a given radius 
of a point on the map

2

Enter the Select mode to select map features within a user-
specified polygon

3

Enter the Select mode to select specific map features 4

Enter the Select mode to select map features that fall within the 
selected map features

5

Open dialog box to create buffers around the selected map 
feature

6

Open dialog box to view distances on the map 7

Display Help F1 or SHIFT + F1

Reload current map F5
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Main Menu Navigation Shortcut Keys

The following shortcut keys are used to navigate among menu items 
appearing on the Autodesk MapGuide Author main menu bar. 

Main Menu Access (Hot) Keys

Autodesk MapGuide Author includes commands that are listed in menus. 
Most menu names or menu items have an underlined character (access or 
hot key). Press ALT along with the access key to open the menu anywhere 
within the active window.

Operation Shortcut Key

Set input focus to the main menu bar. The left-most menu name is 
selected (for example, File)

F10

Move input focus between menu titles on the menu bar in the 
direction of the arrow. 

Left Arrow or 
Right Arrow

Open the selected menu item. Down Arrow selects the next 
command in the list. Up Arrow selects the previous command in 
the list

Up Arrow or 
Down Arrow

Opens the selected menu when input focus is on the menu title. 
Activates a menu item when input focus is on a menu item.

ENTER

Closes an open menu and moves input focus back to the parent 
menu (if present)

ESC

Activate the command of the menu item Underlined 
letter or 
Underlined 
number

Operation Access Key

Open File Menu ALT + F

Open Edit Menu ALT + E

Open Navigate Menu ALT + N
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Map Explorer Navigation Shortcut Keys 

The Map Explorer, which appears on the left side of the Autodesk MapGuide 
Author window, contains the Design tab and the View tab. Both tabs display 
the layers and layer groups in the map. The following shortcut keys are used 
to navigate while working within the Design Tab or the View Tab. 

Note Current input focus must be on the Map Explorer for these keys to work.

Open Bookmark Menu ALT + B

Open Select Menu ALT + S

Open View Menu ALT + V

Open Window Menu ALT + W

Open Help ALT + H

Operation Shortcut Key

Expand item (if collapsed, otherwise select first subfolder) Right Arrow

Collapse item (if expanded, otherwise select parent folder) Left Arrow or 
Backspace

Move up to next visible item (if present) Up Arrow

Move down to next visible item (if present) Down Arrow

Move up one page and select the item Page Up

Move down one page and select the item Page Down

Move to the top and select item Home

Move to the bottom and select item End

Display all sub-items under the selected item NUM LOCK + 
ASTERISK (*) on 
numeric keypad 
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Map Explorer Manipulation Shortcut Keys 

The following keys allow you to manipulate map layer or layer group items. 

Note Current input focus must be on the Map Explorer for shortcut keys to 
work.

Display the contents of the selected item NUM LOCK + PLUS 
SIGN (+) on 
numeric keypad 

Collapse the selected item NUM LOCK + 
MINUS SIGN (-) on 
numeric keypad 

Move forward through Design and View tabs CTRL+TAB

Move backward through Design and View tabs CTRL+SHIFT+TAB

Operation Shortcut Key

View properties for the selected items: 
• Map Layer Properties
• Layer Group Properties

ALT+ENTER

Toggle checkbox (if present) Spacebar

Copy item (Layer, Layer Group, and so on) CTRL + C

Cut item CTRL + X

Paste item CTRL + V

Delete selected item Delete
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Map Layer Popup Menu

To work with map layers, set input focus to the Design tab in the Map 
Explorer window. Use the Up or Down Arrow keys to select a map layer or 
map layer group, then press SHIFT + F10 to activate the Map Layer popup 
menu. When the popup menu appears, you can select menu items by typing 
the underlined letter identified in the label. You use the commands in Map 
Layer popup menu to create, modify, or manipulate the layers in a map. 

Copy selected item CTRL + dragging 
an item

Select more than one item in the Map Explorer as a continuous set SHIFT + any 
arrow key

Add or remove item to/from selection set CTRL + Mouse 
Click 

Operation Shortcut Key

Open popup menu (if present) SHIFT + F10 or 
CTRL + SHIFT + 
F10

Move up to the next menu item Up Arrow 

Move down to the next menu item Down Arrow

Expand menu item (if Right Arrow is present next to label) Right Arrow

Collapse menu item (if expanded) Left Arrow

Open the menu item Underlined 
Letter in menu 
label
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Map Window Navigation Shortcut Keys 

The Map Window, which appears on the right side of the Autodesk 
MapGuide Author program window, displays the map that you are creating 
or updating. To navigate through the map, you use the zoom and pan 
commands. 

Note Current input focus must be on the Map Window for shortcut keys to 
work.

Operation Shortcut Key

Pan Right—Map moves to the left.
Press and hold Right Arrow key to continue to move the map to 
the left.

Right Arrow 

Pan Left—Map moves to the right.
Press and hold Left Arrow to continue to move the map to the 
right.

Left Arrow 

Pan Up—Map moves down.
Press and hold Up Arrow key to continue to move the map down.

Up Arrow

Pan Down—Map moves up.
Press and hold Down Arrow key to continue to move the map up.

Down Arrow

Increases the rate at which the map moves to the left SHIFT + Right 
Arrow

Increases the rate at which the map moves to the right SHIFT + Left 
Arrow

Increases the rate at which the map moves downwards SHIFT + Up 
Arrow

Increases the rate at which the map moves upwards SHIFT + Down 
Arrow

Zoom Out—decrease magnification of a specific area.
Press and hold Page Up key to continue to Zoom Out.

Page Up

Zoom In—increase magnification of a specific area.
Press and hold Page Down key to continue to Zoom In.

Page Down
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Note Pan and zoom rates are controlled by Repeat Delay and Repeat Rate Key-
board properties when the Filter Keys option is enabled. You can adjust these 
rates by changing the Accessibility Options in the Control Panel.

Map Window Manipulation Shortcut Keys 

Note Current input focus must be on the Map Window for shortcut keys to 
work.

Map Window Popup Menu

The Map Window popup menu provides quick access to Map Window dialog 
boxes or commands from the menus and toolbar buttons. Use the 
commands in the popup menu to modify map properties, move around on 
a map, or get information about map features. To activate the Map Window 

Increases the rate at which the specific area zooms out SHIFT + Page Up

Increases the rate at which the specific area zooms in SHIFT + Page 
Down

Unzoom Home

Open Zoom Goto dialog box End

Zoom Previous Backspace

Zoom Previous (browser compatibility) CTRL + Left 
Arrow

Operation Shortcut Key

Copy Map Window to Clipboard CTRL + C or
SHIFT + CTRL + 
C

Select Radius—select features that are within a certain radius. 
Press and hold the ENTER key to increase the size of the selection 
area.

ENTER

Launch Reports ALT+ENTER
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popup menu, press SHIFT + F10. When the popup menu appears in the Map 
Window, you can select menu items by typing the underlined letter identi-
fied in the label.

Dialog Box Shortcut Keys

A dialog box is a window that appears temporarily on top of the Map 
Window or Map Explorer to request information. The following table lists 
the shortcut keys that can be used in each dialog box.

Operation Shortcut Key

Open popup menu (if present) SHIFT + F10 or 
CTRL + SHIFT + 
F10

Moves up to the next menu item Up Arrow 

Moves down to the next menu item Down Arrow

Expand menu item (if Right Arrow is present next to label) Right Arrow

Collapse menu item (if expanded) Left Arrow

Opens the menu item Underlined letter 
in menu label

Operation Shortcut Key

Move forward through tabs CTRL+TAB or CTRL 
+ PAGE DOWN

Move backward through tabs CTRL+SHIFT+TAB 
or CTRL + PAGE UP

Move forward through controls TAB

Move backward through controls SHIFT+TAB
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The following guidelines describe how to use keyboard commands within 
dialog boxes:

Command Buttons

Command buttons, such as OK or Cancel, initiate an immediate action. If 
marked with an ellipsis (…), the command button opens another dialog box. 

A dotted rectangle around the command button indicates that the button 
has input focus. Press SPACEBAR to select the button. Use TAB to move the 
keyboard input focus to the next control, and SHIFT + TAB to reverse the 
direction. Press ALT + the underlined letter to immediately carry out the 
command.

Controls

If a dialog box has a control with an access key (underlined letter) in its title, 
you can move to it or select it by typing ALT + access key. TAB moves the 
keyboard input focus between controls. Arrow keys are used to move within 
a list box, groups of option controls, or groups of page tabs. 

• Execute command button
• Select radio button (option control) 
• Set input focus and select text box 
• Set input focus and select drop-down list contents
• Set input focus and select contents spin box

ALT + underlined 
letter 

Execute command for the button SPACEBAR

Select or clear the check box SPACEBAR

• Select a radio button
• Change value in a spin box
• Move through items in drop-down list or a list box

Arrow keys

Open a folder one level up if a folder is selected in the Save As 
or Open dialog box.

BACKSPACE

Display Help F1

Display the list in drop-down list box F4
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Edit Controls

Edit controls are rectangular boxes used for displaying or editing text. Use 
TAB or ALT + underlined letter to move input focus to the edit control and 
select the text.

Radio Buttons

Radio buttons (or option controls) are used to select only one option from a 
group of options. Use the arrow keys to select the next or previous buttons 
within the group. Press ALT + the underlined letter to move input focus to 
the control and select it. 

Check Boxes

You select or clear check boxes to turn an option on or off. Use TAB to move 
between boxes and SPACEBAR to change the check box to the next state. 
Press ALT + the underlined letter to move input focus to the check box and 
then use SPACEBAR to change the state of the check box. 

Tabbed Pages

Tabbed pages are used to fit many options into a single dialog box. They 
appear visually similar to dividers from a notebook. Each page contains sepa-
rate groups of controls such as check boxes or option controls. Use CTRL + 
TAB or CTRL + PAGE DOWN to move input focus to the next tab and display 
the page. Use CTRL + SHIFT + TAB or CTRL + PAGE UP to move to the 
previous tab and display the page. 

Spin Boxes

Spin boxes appear as a text box with Up and Down Arrows used to select from 
a list of fixed values. Use TAB or ALT + the underlined letter to move the 
keyboard input focus to the text box. Enter the valid value or use the Up 
Arrow or Down Arrow keys to select the next higher or lower values.

Drop-down List Boxes

Drop-down list boxes, by default, display the selected item. There is a small 
button to the right of the control that shows a downward-pointing arrow. 
You show or hide the list by using ALT + Down Arrow, ALT + Up Arrow or F4. 
Use arrow keys to scroll through the list of items, then press SPACEBAR to 
select the item. 
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Operations that Require a Pointing Device

Certain Autodesk MapGuide Author operations require the use of a pointing 
device, such as a mouse or tablet. If you are not using a pointing device, 
consider using mouse emulator software to perform mouse operations from 
your keyboard or other hardware input device. One such mouse emulator is 
Windows MouseKeys, which is available through Accessibility Options in the 
Control Panel. Operations that still require a pointing device are:

■ View Distance
■ Select Polygon
■ View Report (Digitize point)
■ Resizing the Map Explorer or Map Window
■ Setting Bitmap Transparency
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■

■

3
Autodesk MapGuide Server 
and Related Components
 this chapter

Data support

Keyboard accessibility
This chapter describes data support and keyboard 

accessibility enhancements for Autodesk MapGuide 

Server, Autodesk Spatial Data Providers (SDPs), and 

Autodesk MapGuide Server Admin.
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Data Support

This section describes data support enhancements for Autodesk MapGuide 
Server.

New AutoCAD 2004 DWG Format Support

Autodesk MapGuide Server supports the new format for AutoCAD® 2004 
drawing files (DWGs). 

DWG Password Protection

Autodesk MapGuide Server cannot read password-protected DWGs. To read 
DWGs, remove password protection from them. You can still maintain secu-
rity for DWG files using standard file protection and network security proto-
cols among user web servers and your Autodesk MapGuide server machines.

Datum Shift Support

You can configure Autodesk MapGuide Server to perform a datum shift when 
needed. Within North America, this is most often a shift between the NAD27 
and NAD83 datums. 

By default, datum shifting is disabled. To enable datum shift support, use 
regedit to modify the EnableDatumShift registry setting from 0 (disabled) to 
1 (enabled). The specific location of this registry is:

HKEY_LOCAL_MACHINE\SOFTWARE\Autodesk\MapGuide Server\6.3\
Parameters\EnableDatumShift

If datum shifting is enabled, data served by Autodesk MapGuide Server 6.3 
may appear differently than the same data served by earlier releases of 
Autodesk MapGuide. Such differences might be most noticeable in environ-
ments with multiple Autodesk MapGuide servers in which one or more of the 
servers has not been upgraded to Release 6.3.

You will notice a reduction in performance when datum shifting is being 
done. This is expected behavior due to the complexity of these operations. 
Enabling datum shift support has the following effect on performance:

■ If the data and map are in the same coordinate system, then no datum 
shifting is needed and Autodesk MapGuide Server 6.3 is faster than 
Autodesk MapGuide Server 6.0.
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■ If the data and map are in different coordinate systems, but no datum shift 
required, then Autodesk MapGuide Server 6.3 will show slight reduction 
in performance from Autodesk MapGuide Server 6.0.

■ If the data and map are in different coordinate systems and datum shift 
required, then Autodesk MapGuide Server 6.3 will show significant reduc-
tion in performance from Autodesk MapGuide Server 6.0.

Spatial Data Providers Renamed

Autodesk SDPs for Oracle Spatial, SHP, and SDF have been renamed. The new 
names are as follows:

Browsing to SHP and SDF Data Sources

A Browse button is added to the Data Link properties dialog boxes for 
locating SDF and SHP data sources. Instead of typing a path to these data 
sources, you can optionally browse to the path using a standard Windows 
browse dialog box. If you choose to type a path instead, you can enter only 
a single path (see “Multiple Path Support Removed for DWG, SHP, and SDF 
Data Sources” on page 27.)

Multiple Path Support Removed for DWG, SHP, 
and SDF Data Sources

In Release 6.3, multiple search paths for DWG, SDF, and SHP data sources are 
not supported. If you have existing Autodesk MapGuide applications that use 
data sources with multiple paths, you will need to migrate this data to work 
with Autodesk MapGuide 6.3. To do this, you can either move the data from 
the multiple path locations to one common location, or create separate data 
sources for the multiple-path data and reference these new data sources.

Old Name New Name

Autodesk MapGuide Provider for Oracle® 

Spatial
Autodesk Provider for Oracle® Spatial 

Autodesk MapGuide Provider for SHP Autodesk Provider for SHP 

Autodesk MapGuide Provider for SDF Autodesk Provider for SDF
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Oracle 9i Geodetic and Data/Spatial Index 
Dimensionality Support

Beginning in Release 6.3, Autodesk Provider for Oracle Spatial supports 
Oracle 9i geodetic data and handles differences in data/spatial index dimen-
sionality. By default, both geodetic data and dimensionality support are 
disabled. You can selectively enable this support for all Oracle data requests. 
If support is enabled, you will notice performance differences between 
Release 6.3 and Release 6.0.

To enable geodetic checking, use regedit to change the following registry 
setting from 0 (disabled) to 1 (enabled):

HKEY_LOCAL_MACHINE\SOFTWARE\Autodesk\OracleSDP\Parameters\ 
EnableGeodeticCheck

To enable data/spatial index dimensionality checking, use regedit to change 
the following registry setting from 0 (disabled) to 1 (enabled):

HKEY_LOCAL_MACHINE\SOFTWARE\Autodesk\OracleSDP\Parameters\ 
EnableDimensionalityCheck
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Keyboard Accessibility

This section describes enhancements to keyboard accessibility for Autodesk 
MapGuide Server Admin.

Dialog Box Shortcut Keys

A dialog box is a window that appears temporarily on top of the Map 
Window or Map Explorer to request information. The following table lists 
the shortcut keys that can be used in each dialog box.

Operation Shortcut Key

Move forward through tabs CTRL+TAB or CTRL 
+ PAGE DOWN

Move backward through tabs CTRL+SHIFT+TAB 
or CTRL + PAGE UP

Move forward through controls TAB

Move backward through controls SHIFT+TAB

• Execute command button
• Select radio button (option control) 
• Set input focus and select text box 
• Set input focus and select drop-down list contents
• Set input focus and select contents spin box

ALT + underlined 
letter 

Execute command for the button SPACEBAR

Select or clear the check box SPACEBAR

• Select a radio button
• Change value in a spin box
• Move through items in drop-down list or a list box

Arrow keys
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The following guidelines describe how to use keyboard commands within 
dialog boxes:

Command Buttons

Command buttons, such as OK or Cancel, initiate an immediate action. If 
marked with an ellipsis (…), the command button opens another dialog box. 

A dotted rectangle around the command button indicates that the button 
has input focus. Press SPACEBAR to select the button. Use TAB to move the 
keyboard input focus to the next control, and SHIFT + TAB to reverse the 
direction. Press ALT + the underlined letter to immediately carry out the 
command.

Controls

If a dialog box has a control with an access key (underlined letter) in its title, 
you can move to it or select it by typing ALT + access key. TAB moves the 
keyboard input focus between controls. Arrow keys are used to move within 
a list box, groups of option controls, or groups of page tabs. 

Edit Controls

Edit controls are rectangular boxes used for displaying or editing text. Use 
TAB or ALT + underline letter to move input focus to the edit control and 
select the text.

Radio Buttons

Radio buttons (or option controls) are used to select only one option from a 
group of options. Use the arrow keys to select the next or previous buttons 
within the group. Press ALT + the underlined letter to move input focus to 
the control and select it. 

Open a folder one level up if a folder is selected in the Save As 
or Open dialog box.

BACKSPACE

Display Help F1

Display the list in drop-down list box F4
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Check Boxes

You select or clear check boxes to turn an option on or off. Use TAB to move 
between boxes and SPACEBAR to change the check box to the next state. 
Press ALT + the underlined letter to move input focus to the check box and 
then use SPACEBAR to change the state of the check box. 

Tabbed Pages

Tabbed pages are used to fit many options into a single dialog box. They 
appear visually similar to dividers from a notebook. Each page contains sepa-
rate groups of controls such as check boxes or option controls. Use CTRL + 
TAB or CTRL + PAGE DOWN to move input focus to the next tab and display 
the page. Use CTRL + SHIFT + TAB or CTRL + PAGE UP to move to the 
previous tab and display the page. 

Spin Boxes

Spin boxes appear as a text box with up and Down Arrows used to select from 
a list of fixed values. Use TAB or ALT + the underlined letter to move the 
keyboard input focus to the text box. Enter the valid value or use the Up 
Arrow or Down Arrow keys to select the next higher or lower values.

Drop-down List Boxes

Drop-down list boxes, by default, display the selected item. There is a small 
button to the right of the control that shows a downward-pointing arrow. 
You show or hide the list by using ALT + Down Arrow, ALT + Up Arrow or F4. 
Use arrow keys to scroll through the list of items, then press SPACEBAR to 
select the item. 
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4
Autodesk MapGuide Viewers
 this chapter

Data support

Keyboard accessibility
This chapter describes data support and keyboard 

accessibility enhancements for Autodesk MapGuide 

Viewers.
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Data Support

This section describes data support enhancements for Autodesk MapGuide 
Viewers.

Autodesk DWF (Design Web Format) Support

Autodesk DWF™ (Design Web Format™) is a fast, efficient way to distribute 
design data over the Web. If a DWG file, an SDF file, or a database contains 
valid DWF URLs, Autodesk MapGuide Viewer launches Autodesk Express 
Viewer when you double-click an object containing a DWG link. This viewer 
then displays the DWF file content. To be valid, a DWF URL must be in a URL 
property column of the DWG file, SDF file, or database.

Note To take advantage of this functionality, you must first install Autodesk 
Express Viewer. You can download Autodesk Express Viewer from the following 
location: http://www.autodesk.com/expressviewer.

Raster Image Rotation Support

Autodesk MapGuide Viewers can display rotated raster images if the image 
already contains rotation information. Autodesk MapGuide will interpret the 
rotation coordinates and display the image accordingly. For more informa-
tion, see “Working with Rotation and Transparency” on page 52.

Keyboard Accessibility

This section describes new and changed features for Autodesk MapGuide 
Viewers: Autodesk MapGuide Viewer ActiveX control, Autodesk MapGuide 
Viewer Plug-In, and Autodesk MapGuide Viewer, Java Edition. 

The user interface is enhanced to improve keyboard accessibility, including 
keyboard shortcuts and screen changes for input focus designation. 

Input Focus

As with all applications running under Windows, only one window at a time 
can receive input from the keyboard. The window that receives this input is 
the window with input focus. 
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Legend

The Legend within an Autodesk MapGuide Viewer displays a hierarchical list 
of layers. When the Legend has input focus, the layer item is highlighted 
using the Control Panel Appearance color settings for Selected Items. When 
the Legend does not have input focus, it displays Inactive Selected Items 
color settings.

Map Window Input Focus 

The Map Window within an Autodesk MapGuide Viewer displays the map. 
A Map Window with input focus has a rectangular inset border 

General Shortcut Keys

Autodesk MapGuide Viewer allows you to interact with maps that were 
created using Autodesk MapGuide Author. Use the following shortcut keys in 
all versions of Autodesk MapGuide Viewers.

Command Press

Set input focus to Map Explorer [

Set input focus to Map Window ]

Set input focus to Map Window, Select Mode 1

Set input focus to Map Window, Select Radius 2

Set input focus to Map Window, Select Polygon 3

Set input focus to Map Window, Select Features… 4

Set input focus to Map Window, Select Within… 5

Set input focus to Map Window, View Buffer… 6

Set input focus to Map Window, View Distance Mode 7

Display the corresponding menu ALT + Underlined 
letter in a menu 
name
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Map Explorer

The Map Explorer, which appears on the left side of the Autodesk MapGuide 
Viewer window, allows you view map layers and layer group details. 

Map layers are like transparencies that can be stacked and viewed at one 
time, or viewed separately. A map can also contain groups of layers, from 
which you can turn on or off all of the layers in the group at one time. 

Note Current input focus must be on Map Explorer for shortcut keys to work.

Carry out the corresponding command Underlined letter in 
a command name 
on an open menu

Display Help CTRL + F1

Open shortcut menu, if present SHIFT + F10

Open shortcut menu, if present for MapGuide Plug-in/Netscape 
compatibility

CTRL+SHIFT+F10

Stop Loading data when loading.
Cancel tool (return to Selection mode) when tool is active.
Clear selection when features are selected in map.

Esc

Command Press

For Autodesk MapGuide Viewer ActiveX Control and Plug-In:
• Expand item. Display current selection if it’s collapsed, or 

select first subfolder.
For Autodesk MapGuide Viewer Java Edition:
• Expand item, or if item cannot be expanded or is already 

expanded, traverse down to and select the next visible item

Right Arrow

For Autodesk MapGuide Viewer ActiveX Control and Plug-In:
• Collapse item. Collapse current selection if it is expanded or 

select parent folder.
For Autodesk MapGuide Viewer Java Edition: 
• Collapse item, or if item cannot be collapsed or is already 

collapsed traverse up to and select the next higher item.

Left Arrow
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For Autodesk MapGuide Viewer ActiveX Control and Plug-In:
• Collapse item. If item is collapsed then move to next higher 

item.
For Autodesk MapGuide Viewer Java Edition: 
• Does nothing.

Backspace

Traverse up to next visible item, if present Up Arrow

Traverse down to next visible item, if present Down Arrow

Toggle checkbox, if present Spacebar

Scroll up one page and select the item Page Up

Scroll down one page and select the item Page Down

Scroll to the top and select the item Home

Scroll to the bottom and select the item End

For Autodesk MapGuide Viewer ActiveX Control and Plug-In:
• Display all sub-items under the selected item.
For Autodesk MapGuide Viewer Java Edition: 
• Does nothing.

NUM 
LOCK+ASTERISK 
on numeric keypad 
(*)

For Autodesk MapGuide Viewer ActiveX Control and Plug-In:
• Display the contents of the selected item.
For Autodesk MapGuide Viewer Java Edition: 
• Does nothing

NUM LOCK+PLUS 
SIGN on numeric 
keypad (+)

For Autodesk MapGuide Viewer ActiveX Control and Plug-In:
• Collapse the selected item.
For Autodesk MapGuide Viewer Java Edition: 
• Does nothing

NUM 
LOCK+MINUS 
SIGN on numeric 
keypad (-)

Move forward through tabs CTRL+TAB

Move backward through tabs CTRL+SHIFT+TAB
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Map Layer Popup Menu Shortcut Keys

To open the map layer Popup menu, set input focus to the Map Explorer 
window. Use the Up/Down Arrow keys to select a map layer or map layer 
group, then press SHIFT + F10 to open the Map Layer popup menu. When 
the popup menu appears, you can select menu items by typing the under-
lined letter identified in the label. 

Note Current input focus must be on Map Explorer for shortcut keys to work.

Map Window

Using Autodesk MapGuide viewer, you can zoom in and out on a map or 
move the map to display areas that are outside the current view. Use the 
following shortcut keys to activate the zoom and pan functionality. 

Command Press

Open popup menu (if present) SHIFT + F10 or 
CTRL + SHIFT + 
F10

Move up to the next menu item Up Arrow 

Move down to the next menu item Down Arrow

Expand menu item (if right arrow is present next to label) Right Arrow

Collapse menu item (if expanded) Left Arrow

Opens the menu item Underlined 
Letter in menu 
label
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Note Current input focus must be on the Map Window for shortcut keys to 
work.

Command Press

Pan Right—Map moves to the left.
Press and hold Right Arrow key to continue to move the map to 
the left. 

Right Arrow 

Pan Left—Map moves to the right. 
Press and hold Left Arrow to continue to move the map to the 
right.

Left Arrow 

Pan Up—Map moves down.
Press and hold Up Arrow key to continue to move the map down.

Up Arrow

Pan Down—Map moves up.
Press and hold Down arrow key to continue to move the map up. 

Down Arrow

Increases the rate at which the map pans to the left. SHIFT + Right 
Arrow

Increases the rate at which the map pans to the right. SHIFT + Left 
Arrow

Increases the rate at which the map pans down. SHIFT + Up 
Arrow

Increases the rate at which the map pans up. SHIFT + Down 
Arrow

Zoom Out—decreases magnification of a specific area. 
Press and hold Page Up key to continue to zoom out.

Page Up

Zoom In—increases magnification of a specific area. 
Press and hold Page Down key to continue to zoom in.

Page Down

Increases the rate at which the specific area zooms out. SHIFT + Page Up

Increases the rate at which the specific area zooms in. SHIFT + Page 
Down

Unzoom Home
Keyboard Accessibility | 39



Note Pan and zoom rates are controlled by Repeat Delay and Repeat Rate Key-
board properties. You can adjust these rates by changing the Keyboard settings 
in the Control Panel.

Map Window Manipulation Shortcut Keys 

Note Current input focus must be on the Map Window for shortcut keys to 
work.

Map Window Popup Menu

The Map Window popup menu provides quick access to Map Window dialog 
boxes or commands from toolbar buttons. To open the Map Window popup 
menu, press SHIFT + F10 when the Map Window has input focus. When the 
popup menu appears in the Map Window, you can select menu items by 
typing the underlined letter identified in the label. Which popup menu 
commands appear depend on how the map was created. You may not see all 
commands listed in the following table, or you may notice some custom 
commands not in this list. 

Open Zoom Goto dialog box End

Zoom Previous Backspace

Zoom Previous CTRL + Left 
Arrow

Command Press

Copy Map Window to Clipboard SHIFT + C

Select Radius—Select features that are within a certain radius. 
Press and hold the ENTER key to increase the size of the selection 
area. 

ENTER

Launch Reports ALT+ENTER
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Note Current input focus must be on the Map Window for shortcut keys to 
work.

Dialog Box Shortcut Keys

A dialog box is a window that appears temporarily on top of the Map 
Window or Map Explorer to request information. The following table lists 
the shortcut keys that can be used in each dialog box.

Command Press

Open popup menu (if present) SHIFT + F10 or 
CTRL + SHIFT + 
F10

Moves up to the next menu item Up Arrow 

Moves down to the next menu item Down Arrow

Expand menu item (if right arrow is present next to label) Right Arrow

Collapse menu item (if expanded) Left Arrow

Open the menu item Underlined letter 
in menu label

Operation Shortcut Key

Move forward through tabs CTRL+TAB or CTRL 
+ PAGE DOWN

Move backward through tabs CTRL+SHIFT+TAB 
or CTRL + PAGE UP

Move forward through controls TAB

Move backward through controls SHIFT+TAB
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The following guidelines describe how to use keyboard commands within 
dialog boxes:

Command Buttons

Command buttons, such as OK or Cancel, initiate an immediate action. If 
marked with an ellipsis (…), the command button opens another dialog box. 

A dotted rectangle around the command button indicates that the button 
has input focus. Press SPACEBAR to select the button. Use TAB to move the 
keyboard input focus to the next control, and SHIFT + TAB to reverse the 
direction. Press ALT + the underlined letter to immediately carry out the 
command.

Controls

If a dialog box has a control with an access key (underlined letter) in its title, 
you can move to it or select it by typing ALT + access key. TAB moves the 
keyboard input focus between controls. Arrow keys are used to move within 
a list box, groups of option controls, or groups of page tabs. 

• Execute command button
• Select radio button (option control) 
• Set input focus and select text box 
• Set input focus and select drop-down list contents
• Set input focus and select contents spin box

ALT + underlined 
letter 

Execute command for the button SPACEBAR

Select or clear the check box SPACEBAR

• Select a radio button
• Change value in a spin box
• Move through items in drop-down list or a list box

Arrow keys

Open a folder one level up if a folder is selected in the Save As 
or Open dialog box.

BACKSPACE

Display Help F1

Display the list in drop-down list box F4
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Edit Controls

Edit controls are rectangular boxes used for displaying or editing text. Use 
TAB or ALT + underline letter to move input focus to the edit control and 
select the text.

Radio Buttons

Radio buttons (or option controls) are used to select only one option from a 
group of options. Use the arrow keys to select the next or previous buttons 
within the group. Press ALT + the underlined letter to move input focus to 
the control and select it. 

Check Boxes

You select or clear check boxes to turn an option on or off. Use TAB to move 
between boxes and SPACEBAR to change the check box to the next state. 
Press ALT + the underlined letter to move input focus to the check box and 
then use SPACEBAR to change the state of the check box. 

Tabbed Pages

Tabbed pages are used to fit many options into a single dialog box. They 
appear visually similar to dividers from a notebook. Each page contains sepa-
rate groups of controls such as check boxes or option controls. Use CTRL + 
TAB or CTRL + PAGE DOWN to move input focus to the next tab and display 
the page. Use CTRL + SHIFT + TAB or CTRL + PAGE UP to move to the 
previous tab and display the page. 

Spin Boxes

Spin boxes appear as a text box with up and Down Arrows used to select from 
a list of fixed values. Use TAB or ALT + the underlined letter to move the 
keyboard input focus to the text box. Enter the valid value or use the Up 
Arrow or Down Arrow keys to select the next higher or lower values.

Drop-down List Boxes

Drop-down list boxes, by default, display the selected item. There is a small 
button to the right of the control that shows a downward-pointing arrow. 
You show or hide the list by using ALT + Down Arrow, ALT + Up Arrow or F4. 
Use arrow keys to scroll through the list of items, then press SPACEBAR to 
select the item. 
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Operations that Require a Pointing Device

Certain operations for Autodesk MapGuide Viewer ActiveX Control and 
Plug-In require the use of a pointing device, such as a mouse or tablet. If you 
are not using a pointing device, consider using mouse emulator software to 
perform mouse operations from your keyboard. Autodesk MapGuide Viewer 
operations that require a pointing device are:

■ View Distance
■ Select Polygon
■ View Report (Digitize point)

Autodesk MapGuide Viewer Java Edition 
Differences

The following are behavioral differences between Autodesk MapGuide 
Viewer Java Edition and other Autodesk MapGuide Viewers.

■ On some implementations of Java, when input focus is shifted from a 
component to another application or window, input focus may not go 
back to the component that last had input focus.

■ Pressing the space bar toggles the visibility of a layer in the Legend. For 
Autodesk MapGuide Viewer Java Edition, the new state will be the inverse 
of the first selected item in the legend. This is different from standard tree 
behavior where the new state is the inverse of item with input focus. 

■ The legend may not use system colors when being displayed. 

■ The legend may not change colors when the system colors are changed 
through the System Display Properties dialog box. To get the new colors, 
restart the browser.

■ If you are running Autodesk MapGuide Viewer Java Edition on an Apple 
Macintosh computer, keyboard accessibility does not work for certain 
operations.

■ Help buttons for dialogs are not available in Autodesk MapGuide Viewer 
Java Edition. To get dialog Help, either select the Help (?) icon or right 
click and select Help > Help Contents, then navigate to the appropriate 
dialog topic. 
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Symbol Manager
 this chapter

Keyboard accessibility
This chapter describes keyboard accessibility 

enhancements for Symbol Manager.
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Keyboard Accessibility

This section describes enhancements to keyboard accessibility for Symbol 
Manager.

Main Menu Shortcut keys

The following shortcut keys are used to activate menu items appearing on 
the Symbol Manager main menu bar. An ellipsis (…) after the menu item 
indicates that a dialog box will appear after the command is chosen.

Command Press 

Create a new symbol CTRL + N

Open an existing symbol CTRL + O

Save the active symbol CTRL + S

Cut symbol CTRL + X

Copy symbol CTRL + C

Paste symbol CTL + V

Select All CTRL + A

Clear DELETE

Display Help F1 

Set input focus to the main menu bar. The left-most menu name is 
selected (for example, File)

F10

Move input focus between menu titles on the menu bar in the 
direction of the arrow.

Left Arrow or 
Right Arrow

Open the selected menu item. Down Arrow selects the next 
command in the list. Up Arrow selects the previous command in 
the list

Up Arrow or 
Down Arrow
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Main Menu Access Keys

Most menu names or menu items have an underlined character (access key). 
You can press ALT along with the access key to open the menu item 
anywhere within the active window.

Dialog Box Shortcut Keys

A dialog box is a window that appears temporarily on top of the Map 
Window or Map Explorer to request information. The following table lists 
the shortcut keys that can be used in each dialog box.

Open the selected menu when input focus is on the menu title. 
Activate a menu item when input focus is on a menu item.

ENTER

Close an open menu and move input focus back to the parent 
menu (if present).

ESC

Initiate the command of the menu item Underlined letter 
or Underlined 
number

Command Press

Open File Menu ALT + F

Open Edit Menu ALT + E

Open Tools Menu ALT + T

Open Help Menu ALT + H

Operation Shortcut Key

Move forward through tabs CTRL+TAB or CTRL 
+ PAGE DOWN

Move backward through tabs CTRL+SHIFT+TAB 
or CTRL + PAGE UP
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The following guidelines describe how to use keyboard commands within 
dialog boxes:

Command Buttons

Command buttons, such as OK or Cancel, initiate an immediate action. If 
marked with an ellipsis (…), the command button opens another dialog box. 

A dotted rectangle around the command button indicates that the button 
has input focus. Press SPACEBAR to select the button. Use TAB to move the 
keyboard input focus to the next control, and SHIFT + TAB to reverse the 
direction. Press ALT + the underlined letter to immediately carry out the 
command.

Move forward through controls TAB

Move backward through controls SHIFT+TAB

• Execute command button
• Select radio button (option control) 
• Set input focus and select text box 
• Set input focus and select drop-down list contents
• Set input focus and select contents spin box

ALT + underlined 
letter 

Execute command for the button SPACEBAR

Select or clear the check box SPACEBAR

• Select a radio button
• Change value in a spin box
• Move through items in drop-down list or a list box

Arrow keys

Open a folder one level up if a folder is selected in the Save As 
or Open dialog box.

BACKSPACE

Display Help F1

Display the list in drop-down list box F4
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Controls

If a dialog box has a control with an access key (underlined letter) in its title, 
you can move to it or select it by typing ALT + access key. TAB moves the 
keyboard input focus between controls. Arrow keys are used to move within 
a list box, groups of option controls, or groups of page tabs. 

Edit Controls

Edit controls are rectangular boxes used for displaying or editing text. Use 
TAB or ALT + underline letter to move input focus to the edit control and 
select the text.

Radio Buttons

Radio buttons (or option controls) are used to select only one option from a 
group of options. Use the arrow keys to select the next or previous buttons 
within the group. Press ALT + the underlined letter to move input focus to 
the control and select it. 

Check Boxes

You select or clear check boxes to turn an option on or off. Use TAB to move 
between boxes and SPACEBAR to change the check box to the next state. 
Press ALT + the underlined letter to move input focus to the check box and 
then use SPACEBAR to change the state of the check box. 

Tabbed Pages

Tabbed pages are used to fit many options into a single dialog box. They 
appear visually similar to dividers from a notebook. Each page contains sepa-
rate groups of controls such as check boxes or option controls. Use CTRL + 
TAB or CTRL + PAGE DOWN to move input focus to the next tab and display 
the page. Use CTRL + SHIFT + TAB or CTRL + PAGE UP to move to the 
previous tab and display the page. 

Spin Boxes

Spin boxes appear as a text box with up and Down Arrows used to select from 
a list of fixed values. Use TAB or ALT + the underlined letter to move the 
keyboard input focus to the text box. Enter the valid value or use the Up 
Arrow or Down Arrow keys to select the next higher or lower values.
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Drop-down List Boxes

Drop-down list boxes, by default, display the selected item. There is a small 
button to the right of the control that shows a downward-pointing arrow. 
You show or hide the list by using ALT + Down Arrow, ALT + Up Arrow or F4. 
Use arrow keys to scroll through the list of items, then press SPACEBAR to 
select the item. 

Operations that Require a Pointing Device

Autodesk MapGuide Symbol Manger requires the use of a pointing device, 
such as a mouse or tablet, for setting bitmap transparency. If you are not 
using a pointing device, consider using mouse emulator software to perform 
mouse operations from your keyboard. 
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Raster Workshop
 this chapter

Data support

Keyboard accessibility
This chapter describes data support and keyboard 

accessibility enhancements for Raster Workshop.
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Data Support

This section describes data support enhancements for Raster Workshop.

Working with Rotation and Transparency

Autodesk MapGuide Author can interpret and display rotated raster images. 
You can rotate raster images using Autodesk Raster Design 2004 and combine 
them into one or more Raster Image Catalog (RIC) files using Raster 
Workshop. 

When using a RIC file containing rotated raster images, all images (rotated or 
not) within the RIC file are rendered in PNG format. This conversion also 
happens for images that contain transparency information, whether or not 
they are rotated. PNG files are typically larger than other raster file formats 
(such as JPG) and take longer to send to clients. Because of this design, follow 
these guidelines to ensure optimum server-to-client performance:

■ When creating a RIC file containing rotated images, you must use Release 
6.3 of Raster Workshop.

■ Do not mix rotated images and non-rotated (orthogonal) images in the 
same RIC file. Instead create separate RIC files for non-rotated images and 
for images with rotation or transparency information.

■ When working with transparent images, you can improve performance by 
creating transparent tiled TIFF files with Raster Workshop.

Keyboard Accessibility

This section describes enhancements to keyboard accessibility for Raster 
Workshop.
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Dialog Box Shortcut Keys

A dialog box is a window that appears temporarily on top of the Map 
Window or Map Explorer to request information. The following table lists 
the shortcut keys that can be used in each dialog box.

Operation Shortcut Key

Move forward through tabs CTRL+TAB or CTRL 
+ PAGE DOWN

Move backward through tabs CTRL+SHIFT+TAB 
or CTRL + PAGE UP

Move forward through controls TAB

Move backward through controls SHIFT+TAB

• Execute command button
• Select radio button (option control) 
• Set input focus and select text box 
• Set input focus and select drop-down list contents
• Set input focus and select contents spin box

ALT + underlined 
letter 

Execute command for the button SPACEBAR

Select or clear the check box SPACEBAR

• Select a radio button
• Change value in a spin box
• Move through items in drop-down list or a list box

Arrow keys

Open a folder one level up if a folder is selected in the Save As 
or Open dialog box.

BACKSPACE

Display Help F1

Display the list in drop-down list box F4
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The following guidelines describe how to use keyboard commands within 
dialog boxes:

Command Buttons

Command buttons, such as OK or Cancel, initiate an immediate action. If 
marked with an ellipsis (…), the command button opens another dialog box. 

A dotted rectangle around the command button indicates that the button 
has input focus. Press SPACEBAR to select the button. Use TAB to move the 
keyboard input focus to the next control, and SHIFT + TAB to reverse the 
direction. Press ALT + the underlined letter to immediately carry out the 
command.

Controls

If a dialog box has a control with an access key (underlined letter) in its title, 
you can move to it or select it by typing ALT + access key. TAB moves the 
keyboard input focus between controls. Arrow keys are used to move within 
a list box, groups of option controls, or groups of page tabs. 

Edit Controls

Edit controls are rectangular boxes used for displaying or editing text. Use 
TAB or ALT + underline letter to move input focus to the edit control and 
select the text.

Radio Buttons

Radio buttons (or option controls) are used to select only one option from a 
group of options. Use the arrow keys to select the next or previous buttons 
within the group. Press ALT + the underlined letter to move input focus to 
the control and select it. 

Check Boxes

You select or clear check boxes to turn an option on or off. Use TAB to move 
between boxes and SPACEBAR to change the check box to the next state. 
Press ALT + the underlined letter to move input focus to the check box and 
then use SPACEBAR to change the state of the check box. 
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Tabbed Pages

Tabbed pages are used to fit many options into a single dialog box. They 
appear visually similar to dividers from a notebook. Each page contains sepa-
rate groups of controls such as check boxes or option controls. Use CTRL + 
TAB or CTRL + PAGE DOWN to move input focus to the next tab and display 
the page. Use CTRL + SHIFT + TAB or CTRL + PAGE UP to move to the 
previous tab and display the page. 

Spin Boxes

Spin boxes appear as a text box with up and Down Arrows used to select from 
a list of fixed values. Use TAB or ALT + the underlined letter to move the 
keyboard input focus to the text box. Enter the valid value or use the Up 
Arrow or Down Arrow keys to select the next higher or lower values.

Drop-down List Boxes

Drop-down list boxes, by default, display the selected item. There is a small 
button to the right of the control that shows a downward-pointing arrow. 
You show or hide the list by using ALT + Down Arrow, ALT + Up Arrow or F4. 
Use arrow keys to scroll through the list of items, then press SPACEBAR to 
select the item. 
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SDF Loader
 this chapter

Data support enhancements
This chapter describes data support enhancements for 

SDF Loader.
57



Data Support Enhancements

This section describes data support enhancements for SDF Loader.

New AutoCAD 2004 DWG Format

SDF Loader supports the new drawing file (DWG) format introduced by 
AutoCAD 2004. 

MPolygon Support

MPolygon is a new DWG entity added by AutoCAD 2004. In AutoCAD 2004, 
this feature allows users to create polygon objects by selecting existing closed 
polyline object and circles, or by specifying points for boundary segments or 
arcs. 

When SDF Loader converts an AutoCAD DWG file that contains MPolygons, 
the MPolygons are rendered as polypolygons in the resulting SDF file. During 
this conversion, the MPolygon will lose its fill (hatching) properties. 
Autodesk MapGuide Author displays the MPolygon with a solid fill style by 
default. You can change the fill style as needed using Autodesk MapGuide 
Author.
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